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• 13—25 GHz Low-Noise and Driver Amplifier

• 16 dBm Typical Output P1dB

• 23 dB Small-Signal Gain

• 1.9 dB Typical Noise Figure

• > 8 dB Return Loss Input and Output

• +4 V, 65 mA Nominal Bias

• 16 Lead QFN, 2.5 mm × 2.5 mm

ARF1205Q2 is a low-noise and driver amplifier designed for high data-rate applications. With 23 dB of linear gain,
1.9 dB noise figure, 17 dBm output P1dB and low-current operation, it is well suited to demanding, high-order
modulation schemes. The circuit typically draws 65 mA from a 4 V DC supply in buffer amplifier bias, or 40 mA from
a 3.3 V supply in low-noise bias. The part is internally matched to 50 Ω with ESD protection. The part has internal
bias regulation controlled by VBIAS, or alternatively by a resistor between VDD and VBIAS.

The part is RoHS* compliant and built with the latest manufacturing techniques to optimize for reliability and 
quality.

Export from The Netherlands/EU, no licence.

Description

Functional Diagram

Applications
• ISM

• VSAT

• Point-to-Point Radios

All not connected (N/C) pins should be 
connected to RF and thermal ground.

*RoHS compliant — European Union Directive 2011/65/EU 

Features

Please refer to 
Datasheet Design 
Guidelines for 
preferred 
features and 
applications

File->Info->Document Title
Don’t Change “Altum RF Datasheet”

Change 
“ARFxxxQy” in 
master slide to 
appropriate part 
number

Leave the orange 
notes. They won’t 
be exported but 
gives other users 
prompts for 
editing

Pin Pin Name Description

2 RFIN RF Input

5 VBIAS
Current Control & Power 

Down

8 VDD Power Supply

11 RFOUT RF Output

1, 3, 7, 10, 12, 
14, Paddle

GND Ground

4, 6, 9, 13, 15, 
16

N/C Unconnected Pins.
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1. Parameters tested at 25ºC in laboratory environment with standard 50 Ω matched equipment.
2. Nominal bias of VDD = 4.0 V and VBIAS = 3.3 V (IDD  65 mA).

Return loss for <50 GHz 
should be de-embedded. 
If greater than 50 GHz 
add additional subscript 
note for “Reference plane 
for the return loss is to 
the RF connectors of 
evaluation board”

Electrical Specifications, Buffer Amplifier Bias1,2

Parameter Test Conditions Min Typ Max Units

Frequency Range 13 25 GHz

Small Signal Gain

13 GHz
16 GHz
22 GHz
25 GHz

24.5
25.5
20.0
19.5

26.5
27.5
22.0
21.5

28.5
29.5
24.0
23.5

dB

Gain Variation over Temperature 0.01 dB/ºC

Noise Figure

13 GHz
16 GHz
22 GHz
25 GHz

2.4
2.0
2.0
2.0

dB

Input Return Loss

13 GHz
16 GHz
22 GHz
25 GHz

8
14
19
7

dB

Output Return Loss

13 GHz
16 GHz
22 GHz
25 GHz

14
11
8
8

dB

Reverse Isolation

13 GHz
16 GHz
22 GHz
25 GHz

56
50
47
48

dB

Output P1dB

13 GHz
16 GHz
22 GHz
25 GHz

14.5
16.0
17.4
15.5

dBm

Output IP3

13 GHz, POUT/tone = +5 dBm, ΔF = 10 MHz
16 GHz, POUT/tone = +5 dBm, ΔF = 10 MHz
22 GHz, POUT/tone = +5 dBm, ΔF = 10 MHz
25 GHz, POUT/tone = +5 dBm, ΔF = 10 MHz

24.0
26.5
27.0
27.5

dBm

VDD Voltage Safe Operating Range: 0 to 4.0 V 3.0 4.0 4.0 V

IDD Current
VBIAS = 3.3 V, VDD = 4.0 V 58 65 70 mA

VBIAS = 4.0 V, VDD = 4.0 V 90 mA

VBIAS Voltage
Nominal Bias 3.3 V

Operating Range 0 4.0 V

IBIAS Current VBIAS = 3.3 V, VDD = 4.0 V 1.1 mA

https://www.altumrf.com/


ARF1205Q2

Final Rev: 2.0 3 Copyright © 2026

3. Nominal bias of VDD = 3.3 V and VBIAS = 2.5 V (IDD  40 mA).

Return loss for <50 GHz 
should be de-embedded. 
If greater than 50 GHz 
add additional subscript 
note for “Reference plane 
for the return loss is to 
the RF connectors of 
evaluation board”

Electrical Specifications, Low-Noise Amplifier Bias1,2

Parameter Test Conditions Min Typ Max Units

Frequency Range 13 25 GHz

Small Signal Gain

13 GHz
16 GHz
22 GHz
25 GHz

25
26
21
20

dB

Gain Variation over Temperature 0.01 dB/ºC

Noise Figure

13 GHz
16 GHz
22 GHz
25 GHz

2.4
1.9
1.9
1.7

dB

Input Return Loss

13 GHz
16 GHz
22 GHz
25 GHz

7
13
18
7

dB

Output Return Loss

13 GHz
16 GHz
22 GHz
25 GHz

14
11
8
8

dB

Reverse Isolation

13 GHz
16 GHz
22 GHz
25 GHz

60
50
48
48

dB

Output P1dB

13 GHz
16 GHz
22 GHz
25 GHz

10.5
12.0
14.5
14.0

dBm

Output IP3

13 GHz, POUT/tone = +5 dBm, ΔF = 10 MHz
16 GHz, POUT/tone = +5 dBm, ΔF = 10 MHz
22 GHz, POUT/tone = +5 dBm, ΔF = 10 MHz
25 GHz, POUT/tone = +5 dBm, ΔF = 10 MHz

18.5
22.0
23.5
25.0

dBm

VDD Voltage Safe Operating Range: 0 to 4.0 V 3.0 3.3 4.0 V

IDD Current
VBIAS = 2.5 V, VDD = 3.3 V 40 mA

VBIAS = 4.0 V, VDD = 4.0 V 90 mA

VBIAS Voltage
Nominal Bias 2.5 V

Operating Range 0 4.0 V

IBIAS Current VBIAS = 2.5 V, VDD = 3.3 V 0.9 mA

https://www.altumrf.com/
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Thermal and Reliability Data

Stresses at or above those listed under Absolute Maximum Ratings may cause permanent damage to the product. 
This is a stress rating only; functional operation of the product at these or any other conditions above those 
indicated in the operational section of this specification is not implied. Operation beyond the maximum operating 
conditions for extended periods may affect product reliability.

ESD Sensitive Device

These devices are ESD sensitive. Proper handling for assembly and use must be maintained at all times. Please see 
JEDEC JESD625B for further information. 

4. All thermal and reliability data is measured or simulated with 85ºC at the package base  (solder junction).
5. Thermal resistance is the difference between the package base  (solder junction) temperature and the channel 

temperature, divided by the DC power consumption.

Delete as 
appropriate

Refer to Datasheet Design Guidelines for Absolute 
Max Ratings per process 

CDM not required for die

Parameter Conditions Min Max Units

VDD Voltage 0 4.4 V

IDD Current 0 100 mA

VBIAS Voltage 0 4.4 V

Total Dissipated Power 0.8 W

Maximum RF Input Power Peak Power +14 dBm

Channel Temperature +175 °C

Operating Temperature Range -40 +85 °C

Storage Temperature Range -50 +125 °C

Moisture Sensitivity Level IPC/JEDEC J-STD-020E MSL1

ESD Human Body Model (HBM) JEDEC JS-001-2023 Class 1B

ESD Charged Device Model (CDM) JEDEC JS-002-2022 Class C3

Absolute Maximum Ratings

Parameter Conditions2,4 Value Units

Thermal Resistance (RTH)5
VDD = 4 V, IDDQ = 65 mA, Small Signal RF

VDD = 4 V, IDDQ = 65 mA, POUT = 17.5 dBm
194.2
212.5

°C/W

Channel Temperature (TCH)
VDD = 4 V, IDDQ = 65 mA, Small Signal RF

VDD = 4 V, IDDQ = 65 mA, POUT = 17.5 dBm
135.5
127.5

°C

Mean Time To Failure (MTTF)
VDD = 4 V, IDDQ = 65 mA, Small Signal RF

VDD = 4 V, IDDQ = 65 mA, POUT = 17.5 dBm
> 107

> 107 Hours

https://www.altumrf.com/
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Nominal Bias: VDD = 4 V, VBIAS = 3.3 V (IDD ≈ 65 mA)
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Room Temperature: VDD = 4 V, VBIAS = 2.5, 3.3 and 4 V (IDD ≈  0, 65 and  5 mA)
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Nominal Bias: VDD = 4 V, VBIAS = 2.5 V (IDD ≈  0 mA)
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Nominal Bias: VDD = 4 V, VBIAS = 3.3 V (IDDQ ≈ 65 mA)
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All  Plots must use a vector 
format (Paste->Special SVG or 
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All plots must have transparent 
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Nominal Bias: VDD = 4 V, VBIAS = 3.3 V (IDDQ ≈ 65 mA)

  

  

  

  

   

        

  
 
  
 
 

                  

  0 C

25 C

 5 C

IDD vs Output Power at 16 GHz

  

  

  

  

   

        
  
 
  
 
 

                  

  0 C

25 C

 5 C

IDD vs Output Power at 22 GHz

  

  

  

  

   

        

  
 
  
 
 

                  

  0 C

25 C

 5 C

IDD vs Output Power at 25 GHz

Measured Performance – Large Signal

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background

https://www.altumrf.com/


ARF1205Q2

Final Rev: 2.0 10 Copyright © 2026

Nominal Bias: VDD = 4 V, VBIAS = 3.3 V (IDDQ ≈ 65 mA)
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Room Temperature: VDD = 4 V, VBIAS = 2.5, 3.3 and 4 V (IDDQ ≈  0, 65 and  5 mA)
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Room Temperature: VDD = 4 V, VBIAS = 2.5, 3.3 and 4 V (IDDQ ≈  0, 65 and  5 mA)
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Room Temperature: VDD = 4 V, VBIAS = 2.5, 3.3 and 4 V (IDDQ ≈  0, 65 and  5 mA)
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Nominal Bias: VDD = 3.3 V, VBIAS = 2.5 V (IDDQ ≈  0 mA)
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Nominal Bias: VDD = 4 V, VBIAS = 3.3 V (IDDQ ≈ 65 mA)
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Nominal Bias: VDD = 4 V, VBIAS = 3.3 V (IDDQ ≈ 65 mA)
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Room Temperature: VDD = 3.3 V, VBIAS = 2.5 V (IDDQ ≈  0 mA), ΔF = 10 MHz
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Room Temperature: VDD = 4 V, VBIAS = 2.5, 3.3 and 4 V (IDDQ ≈  0, 65 and  5 mA), ΔF = 10 MHz

 

  

  

  

        

 
  
  
  
 
 
 

                           

      
      
      

OIP3 versus POUT/tone at 16 GHz

 

  

  

  

        
 
  
  
  
 
 
 

                           

      
      
      

OIP3 versus POUT/tone at 22 GHz

 

  

  

  

        

 
  
  
  
 
 
 

                           

      
      
      

OIP3 versus POUT/tone at 25 GHz

 

  

  

  

          

 
  
  
  
 
 
 

               

      
      
      

OIP3 at POUT/tone = + 5 dBm

Measured Performance – Linearity

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background

https://www.altumrf.com/


ARF1205Q2

Final Rev: 2.0 19 Copyright © 2026

Biasing

ARF1205Q2 has two biasing methods. The first is VDD and VBIAS which can be biased with separate power supplies.  
By altering VBIAS the current of VDD will change the performance. The second method ties VBIAS to  VDD via a 
resistor. The value of the resistor determines the current of the device and some resistor and current values are 
provided in the evaluation board section.  This method enables the ARF1205Q2 to be biased by a single supply. 

Additionally, while the exact bypass network will be customer specific, we recommend as a minimum to have a 100 
pF capacitor and 10 nF capacitor on both the VDD and VBIAS lines. 

The Altum RF evaluation board ships with pads for biasing via a resistor but typically this isn’t populated. 

Application Schematic

Explain minimum bias 
requirements. This may be 
different to evaluation board. 
For instance if a part can be 
biased by one side only

Check Data design guidelines 
for schematic export tips.

Individual Biasing of VDD and VBIAS

Biasing through resistor

https://www.altumrf.com/
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Bill of Materials Evaluation Board Layout

Evaluation Board Schematic

J2 Pin Description

3 VBIAS

7 VDD

1,5 Unconnected

9,11 Thermistor (optional)

2,4,6,8,10,12 Ground

Description Reference Designator Quantity

ARF1205Q2 U1 1

10 nF 0603 
Capacitor

C1,C4 2

100 pF 0402 
Capacitor

C2,C3 2

 20 Ω 060  
Resistor (optional)

R1 1

12 pin Samtec 
TSM-106-01-F-DH-

P

J2 1

Southwest 
Microwave 2.92mm 

1092-01A-6 or 
equivalent

J1,J3 2

Recommended land-pattern and sample board 
layout for 254 µm thick RO4350 are available on 
request. 
Contact Altum RF Application Support for further 
information. 

Evaluation board Schematic 
should be in black on white.
Convert in inkscape or kicad 
(NOT in Powerpoint)

Set white background to 
transparent
Picture Format->Color-> Set 
Transparent color

Mark components that are not 
populated as DNP

6. VBIAS can be supplied externally or can be generated using the resistor R1 between the VDD rail and the VBIAS pin.

Bias Control6

VDD (V) IDD (mA) VBIAS (V) R1 (Ω 

3.3 65 3.3 0

3.3 40 2.5 820

4.0 85 4.0 0

4.0 65 3.3 560

4.0 40 2.5 1.8k

https://www.altumrf.com/
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1. Bias Turn-on Sequence

VDD and VBIAS can be safely applied in any order, or simultaneously. 

The part has internal bias regulation. VBIAS can be supplied externally or can be generated using the resistor R1. 
Refer to Bias Control table for suggested operating bias condition.

The part can be turned off by applying 0 V to VBIAS or to VDD.

2. Reflow Information

MSL level 1 as per IPC/JEDEC J-STD-020E.

Application Notes

Delete if not applicable
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Outline Drawing

All dimensions are in millimeters.
Package leads and exposed pad are plated with NiPdAu.

Set white background to 
transparent
Picture Format->Color-> Set 
Transparent color

Package Information

YYWW is the date code

XXXX is the lot code

1205 is the part number

    

    

    

 

 

 

 

   

   

  

       

          

Corrected Package for next Rev!
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Part Number Delivery Format Quantity

ARF1205Q2-TR500 Tape and Reel 500 pcs

ARF1205Q2-TR2500 Tape and Reel 2500 pcs

Export from The Netherlands/EU, no licence.

For further information please visit www.altumrf.com or contact us directly at  sales@altumrf.com.

Ordering Information

Document Information
Information provided by Altum RF is believed to be accurate and reliable. However, no responsibility is assumed by Altum RF for its use, nor for any 
infringements of patents or other rights of third parties that may result from its use. All information contained herein is subject to change without 
notice. Customers should obtain and verify the latest relevant information before placing orders. The information contained herein or any use of 
such information does not grant, explicitly or implicitly, to any party any patent rights, licenses, or any other intellectual property rights, whether 
with regard to such information itself or anything described by such information.

Advance: Expected performance based on feasibility analysis, simulations or measured data. All content is subject to change.
Preliminary: Measured performance based on prototype parts. Specifications including maximum and minimum values are subject to change.
Final:  Guaranteed performance of qualified and production released part.

Document Template: ARFDOC-1897081980-202625 (Rev: 1.0)
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mailto:sales@altumrf.com?subject=Information%20about%20ARF1205Q2
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